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Affordable, easy-to-use, accurate and precise 
 

  
Multimeter view Oscilloscope view 

 

Applications include: 

• Microprocessor and microcontroller power profiling and optimization 

• Hardware power optimization 

• Sleep current optimization 

• Hardware and software troubleshooting 

• Software characterization and interrupt service routine profiling 

• USB 2.0 inrush and suspend current pre-compliance testing  

• General purpose current, voltage, power, and energy measurement 

 

The Joulescope™ JS110 is the most affordable and easy-to-use precision DC energy analyzer.  It 

measures current and voltage, then computes power and energy.  Many modern battery powered 

devices and IoT devices have a high dynamic current range which makes accurate measurement difficult.  

When “sleeping” the devices consume nanoamps (nA) or microamps (µA), but when active, they 

consume milliamps (mA) or amps (A).  Joulescope combines high-speed sampling and rapid dynamic 

current range switching to provide accurate and seamless energy measurements, even for devices with 

rapidly varying current consumption.  The unprecedented accuracy and low-cost of Joulescope allows 

every engineer on the team to measure the energy consumed by the target device during development.  

Joulescope provides rapid feedback on how changes affect the overall product battery life.   

Joulescope displays instantaneous voltage, current, power, and energy, like a multimeter.  The 

multimeter provides a quick and easy summary of the present state of your device. 

Joulescope displays waveforms of voltage and current over time, like an oscilloscope.  This oscilloscope 

view allows you to identify and to troubleshoot dynamic behavior and short events including inrush 

current, event handlers, and tasks.   
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Key benefits 
 

• Dynamic range: Joulescope accurately measures electrical current over nine orders of 

magnitude from amps down to nanoamps. This wide range allows accurate and precise current 

measurement for modern devices.  Sleep modes are often just nanoamps (nA) or microamps 

(µA).  Active modes are often milliamps (mA) or amps (A). 

• Low voltage drop: Most multimeters and current meters have a significant voltage drop 

(sometimes called burden voltage or insertion loss) which affects the actual voltage delivered to 

the device under test.  Joulescope has a total voltage drop of 25 mV at 1 A, which keeps your 

target device running correctly.  Joulescope's extremely fast current range switching maintains 

low voltage drop even under rapidly varying current demands. 

• Makes the invisible visible:  Joulescope measures current and voltage 2 million times per 

second with 250 kHz bandwidth.  This high sampling rate makes the power consumption of 

interrupt service routines, inrush currents, and other short events visible. 

• Easy to use:  Joulescope reports cumulative energy consumption along with real-time current, 

voltage, and power. The multimeter view clearly shows the most recent value while the 

oscilloscope view allows you to explore changes over time.  Much simpler and more accurate 

than anything in its class! 

• Customizable:  The Joulescope host software is open source on GitHub.  You can also swap the 

banana jack front panel with front panels that have other connector types!  The front panels are 

open source on GitHub.   

• Portable: Joulescope fits in your backpack and only needs a small part of your desk.  Take 

Joulescope wherever you want to use it! 

• Affordable:  Joulescope is affordable and priced so that every developer on the team can have 

one at their desk.  With such convenient access, Joulescope allows developers to see the impact 

of their changes on energy consumption immediately.  Developers can make informed choices 

to account for battery life during design. Eliminate power consumption surprises during final 

product testing! 
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Key features 
• -1V to 15V voltage range 

• -1A to 3A current range, continuous 

• Up to 10A current pulses (<10 ms, < 3A average per second) 

• Down to 1.5 nA resolution, equivalent to 32-bits of dynamic range 

• Synchronously measures voltage and current at 2 million samples per second, 14-bit 

• 250 kHz bandwidth 

• Rapid 1 μs switching between shunt resistors for seamless dynamic current measurement 

• Computes power and total energy 

• Operates with minimal voltage disturbance between IN and OUT ports 

• Up to ±48V common mode voltage between USB ground and IN-, IN+, OUT+, and OUT- 

• 2 general purpose inputs and 2 general purpose outputs 

• Programmable on/off for power cycling the target device and measuring inrush currents 

• USB 2.0 high-speed host connectivity with full-rate data streaming 

• Host software support for Microsoft® Windows®, Apple® Mac® OS X®, and Linux® 

• Host software provides real-time graphs of current and voltage over time 

• Host software is open source and available on GitHub 

• Swappable front panel with open source designs on GitHub 

• Firmware upgradable 
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What comes in the box 
Your Joulescope JS110 purchase includes: 

• Joulescope JS110 instrument 

• Banana Jack Front Panel, already installed 

• 6’ USB 2.0 A to B cable 

• T15 Torx screwdriver 

• Quick Start Guide 

• Joulescope sticker 

You will need to provide: 

• A host computer which must be running Microsoft® Windows® 10, Window 7, Apple® Mac® 

OS/X® or Linux®.  Most computers manufactured within the last five years should work.  The 

computer requires an available USB 2.0 port, at least 500 MB of hard drive / solid state drive 

storage space, and 1 GB of available RAM.   

• Suitable cable(s) to connect Joulescope to your power source  

• Suitable cable(s) to connect Joulescope to your target device. 

You need an internet connection to download the free software for your computer. 
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Quick start 
Download the host software from http://www.joulescope.com/download.  Follow the instructions on 

the download page to install the software for your platform. 

Start the Joulescope host software. 

 

Connect the Joulescope USB port to the host computer using the provided USB cable.   

 

The host software will automatically detect the connected Joulescope and start displaying data.

 

 

http://www.joulescope.com/download
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Connect the Joulescope IN port to your power source.  If using a configurable power supply, set the 

voltage and current suitable for your device under test.  The maximum voltage between IN+ and IN- 

should never exceed ±15V.  IN and OUT are electrically isolated from USB, but the voltage between any 

port and US ground should never exceed ±48V. 

 

Connect the Joulescope “OUT” port to the power input for your device under test. 

 

Operate your device under test.  Use the Joulescope host software to measure the current, voltage, 

power and total energy consumption.  If desired, dive into more detail with the oscilloscope view 

View → Oscilloscope Default to display waveforms of voltage, current, and power over time. 
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Specifications 

Absolute maximum ratings 
 Min Max Unit 

USB voltage -0.3 6 V 

Max voltage applied between IN+ to IN- -20 20 V 

Max voltage applied between OUT+ to OUT- -20 20 V 

Max voltage to USB ground (IN+, IN-, OUT+, OUT-) -48 48 V 

Input current (powered, burst) -10 10 A 

Input current (powered, sustained) -3 3 A 

Input current (unpowered) -0.5 N/A (off) A 

Storage temperature -40 80 °C 

Operating temperature 0 50 °C 

Relative humidity (non-condensing) 0 95 % 

Altitude from sea level -100 2500 m 

Max voltage applied to GPI relative to USB ground -10 10 V 

 

Mechanical 
 Typical Unit 

Weight 217 grams 

Width 81 mm 

Length (including banana jack front panel) 150 mm 

Height 33 mm 

 

Recommended operating conditions 
 Test condition Min Typical Max Unit 

Operating temperature  10  40 °C 

USB supply voltage  4.5 5.0 5.5 V 

USB supply current    500 mA 

Voltage applied to IN  -1.0  15 V 

Input current continuous -1.5  3 A 

Input current pulse < 10 milliseconds,  
< 3A average 

  10* A 

Input current pulse < 100 milliseconds 
< 3A average 

  5* A 

* Suitable for handling inrush currents when connecting capacitive loads. 

Specification conditions 
Temperature 23 °C ± 10 °C 

Humidity 20% to 80% RH, non-condensing 

Calibration interval 1 year* 

* Recommended to comply with industry standard practices, but Joulescope is designed not to need 

recalibration. 
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Current measurement specifications 
Range Accuracy Resolution Impedance Bandwidth 

10 A* ±0.3% ±7 mA 1 mA 0.01 Ω 250 kHz 

2 A ±0.3% ±1.50 mA 175 µA 0.01 Ω 250 kHz 

180 mA ±0.3% ±150 µA 15 µA 0.11 Ω 250 kHz 

18 mA ±0.25% ±15 µA 1.5 µA 1.11 Ω 250 kHz 

1.8 mA ±0.25% ±1.5 µA 150 nA 11.1 Ω 180 kHz 

180 µA ±0.25% ±150 nA 15 nA 111 Ω 70 kHz 

18 µA ±0.25% ±30 nA 1.5 nA 1111 Ω 15 kHz 

* Joulescope is designed for 3 A sustained.  See the recommend operation conditions for maximum 

durations for higher currents. 

Test current measurement bandwidth by varying the effective load impedance.  Due to load 

capacitance, varying the source voltage is not a valid method of testing current bandwidth. 

Voltage measurement specifications 
Range Accuracy Resolution Impedance Bandwidth 

15 V ±0.1% ±11 mV 1.2 mV - 250 kHz 

5V ±0.1% ±3.5 mV 400 µV - 250 kHz 

 

General specifications 
 Test condition Min Typical Max Unit 

Sampling frequency 25 °C  2000000  sps 

Sampling frequency 25 °C -20  20 ppm 

Front panel insertions    100  

 

Parasitic effects specifications 
 Test condition Min Typical Max Unit 

Current leakage (IN+ to IN-) 25 °C, +3.3V  2  nA 

Current leakage (IN+ to IN-) 25 °C, +5V  2  nA 

Current leakage (IN+ to IN-) 25 °C, +15V  3  nA 

Shunt resistor voltage, max 0 to 2 A, static  20 21 mV 

Burden voltage (IN+ to OUT+) < 1 A, banana jacks 0 25 30 mV 

Burden voltage (OUT- to IN-) < 1 A, banana jacks 0 3 8 mV 

Shunt switching time Over-range 
< 100 ns rise time 

0 0.8 1.2 µs 

Over-range settling time  0 2 5 µs 

Under-range settling time  0 2 5 µs 

 

Software-controlled fuse specifications 
 Test condition Min Typical Max Unit 

Current leakage (IN+ to OUT+) 25 °C, 3.3V  5  nA 

Current leakage (IN+ to OUT+) 25 °C, 5V  7  nA 

Current leakage (IN+ to OUT+) 25 °C, 15V  28 5000 nA 
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General Purpose Inputs & Outputs 
 Test condition Min Typical Max Unit 

Programmable logic level voltage  1.8  VUSB - 
0.2 

V 

Input leakage per pin 25 °C   ±1 μA 

Input leakage per pin    ±2 μA 

Output voltage high -100 μA Vcco-
0.1 

  V 

Output voltage high -4 mA @ 1.65 V 1.2   V 

Output voltage high -8 mA @ 1.65 V 1.9   V 

Output voltage high -24 mA @ 1.65 V 2.4   V 

Output voltage high -32 mA @ 1.65 V 3.8   V 

Output voltage low 100 μA   0.1 V 

Output voltage low 4 mA @ 1.65 V   0.45 V 

Output voltage low 8 mA @ 2.3 V   0.3 V 

Output voltage low 24 mA @ 3 V   0.55 V 

Output voltage low 32 mA @ 4.5 V   0.55 V 

Output impedance 10 mA 90 100 110 Ω 

GPI sample rate   2  MSPS 

Continuous output current Per pin   ±50 mA 

Total power dissipation Over output impedance   0.25 W 

 

The Joulescope uses the TI SN74LVC2T45 for both the GPIs and GPOs.  See the SN74LVC2T45 datasheet 

for more information.  Both the GPIs and GPOs are protected with the Vishay VEMI45AA-HNH which is 

an EMI filter with ESD protection.  The filter is a pi filter with 100 Ohm resistance and capacitance 

between 29 pF and 60 pF. 

 

GPIO Supply 

 Min Typical Max Unit 

+5V output 4.4V VBUS – 0.1 5.5 V 

Current   100 mA 

Output impedance  1  Ω 

 

http://www.ti.com/lit/gpn/sn74lvc2t45
https://www.vishay.com/docs/81385/vemi45aa.pdf
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Host software 
The Joulescope host software runs on a host computer and communicates with the Joulescope unit over 

USB 2.0.  The Joulescope software is available to download at  

www.joulescope.com/download/ 

The software works with Microsoft® Windows® 10, Windows® 7, Apple® Mac® OS/X® and Linux®.  For 

Linux, only Ubuntu 18.04.1 LTS is tested.  Joulescopes software only supports 64-bit operating systems 

with 64-bit python. 

Multimeter view 
Upon launching the host software, you see the multimeter view: 

 

You can return to this view at any time using View → Multimeter. 

The multimeter view provides the present operating state at a glance.  The multimeter view displays 

several quantities: 

• Electrical current in amperes (A) 

• Electrical voltage in volts (V) 

• Power in watts (W) 

• Energy in joules (J) 

http://www.joulescope.com/download/


 

Revision 0.6 - PRELIMINARY Joulescope JS110 User’s Guide Page 14 / 35 
 www.joulescope.com 

This display, along with all other value displays in the Joulescope software, the SI standard prefixes for 

orders of magnitude: 

Prefix Power Name 

G 109 giga- 

M 106 mega- 

k 103 kilo- 

m 10-3 milli- 

µ 10-6 micro- 

n 10-9 nano- 

p 10-12 pico- 

 

The multimeter view updates every half second (0.5 seconds).  The software computes and displays the 

statistics over each half-second time window.  The large numbers are the mean (also called average) 

value of that quantity over the window.  The software also displays: 

• σ: The standard deviation 

• min: The minimum value 

• max: The maximum value 

• p2p: The peak-to-peak value, which is equal to (max – min) 

Note that energy does not display these additional statistics since they are not meaningful.   

Every update normally represents only the data recorded over the last half second.  If you click on the 

“Accumulate” button to activate it, then the software extends the statistics to combine each new 

half-second window without discarding results from previous windows.   
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Oscilloscope view 
The software includes an oscilloscope view.  Click View → Oscilloscope.

 

The first view allows you to control the connected Joulescope.  Press  to pause or resume capturing 

live data.  Press  to start and stop recording data to a file.  This feature is only available when the 

device is capturing live data. 

Current Range allows you to select Joulescope’s active shunt resistor.  Most applications use auto, 

where Joulescope automatically selects the best range.  However, you can manually force the range. 

Voltage Range allows you to select the voltage range.  Joulescope includes a 15V range and a more 

sensitive 5V range. 

The oscilloscope view also displays the energy consumed since the Joulescope software started.  Use 

Tools → Clear Energy to reset the energy to zero. 

The software displays two different waveforms by default.  The top waveform is electrical current, and 

the bottom waveform is electrical voltage.  The x-axis is time.  If you have a Joulescope connected, it will 

automatically add the most recent data to the right of the waveform and shift existing data to the left.  

The y-axis data is the value measured at that point in time.  Joulescope captures data 2 million times per 

second.  When zoomed out, each x-axis pixel may represent many, many samples, which are that pixel’s 

sample window. The plot displays the statistics over each pixel.  The yellow line is the mean (average).  

The red lines are the minimum and maximum.  Power glitches, such as interrupt service routines, are 

very interesting for energy optimization.  The minimum and maximum ensure that you do not miss 

these events, even when zoomed out.  When you eventually zoom in far enough, the red lines disappear 

because 1 pixel becomes 1 sample, and the minimum and the maximum are the same as the average.  
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You can use File → Preferences → Waveform → show_min_max to disable these lines or display the 

minimum to maximum region as a fill instead.   

The software computes statistics quantities over the full time window shown in the present view for 

each waveform.  The software displays the statistics on the right edge of the window.  The statistical 

quantities are: 

• µ: The mean (also called average) value 

• σ: The standard deviation 

• p2p: The peak-to-peak value (max - –in) 

• min: The minimum value 

• max: The maximum value 

• ∫: The integral over the time window  

The waveform view supports Annotations to present additional information, which include: 

• A Single Marker that display information at a single point.  Names used by other equipment for 

this feature include marker and cursor. 

• Dual Markers that display information over a time window.  Names used by other equipment 

for this feature include cursors, timing markers, window, and range selection. 

To display statistics at a single point, move the mouse to the x-axis time labels near the top.  Then right 

click (control click on Mac OS) to bring up the context menu.  Select Annotations → Single Marker. 

 

Left click the marker to move it with the mouse.  As you move the mouse over the waveforms, the 

vertical marker follows along.  The line displays statistics about that location: 

• t: The sample time for the displayed sample or window 

• µ: The mean (also called average) value 

When the location contains more than one sample per displayed pixel, the line displays statistics over 

that single pixel’s sample window: 

• σ: The standard deviation 

• p2p: The peak-to-peak value (max - –in) 

• min: The minimum value 

• max: The maximum value 

Left click again to keep the marker in position. 
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To display statistics over a selectable range, right click on the x-axis time labels and select Annotations 

→ Dual Markers.  Left click a marker to move it with the mouse, then left click again to stop moving the 

marker.  Right click (control click on Mac OS) on one of the dual markers to export data or perform 

analysis over the selected range. 

 

Use the scroll wheel to zoom in and zoom out.  The zoom operation keeps the point under the mouse 

cursor at the same location after the zoom operation.  However, when the maximum extents are 

reached on zoom out, that point may move.  When viewing live data, the zoom operation always keeps 

the most recent data in view at the right. 

Press the left mouse button and drag the cursor left or right to pan in time.  Pan is not supported when 

viewing live data from a Joulescope. 

The software displays on a linear scale with automatic y-axis ranging by default.  The y-axis context 

menu has additional options.  Right click (control click on Mac OS) on a y-axis to display the menu. 

 

When manual ranging is activated, hover over the y-axis and use the scroll wheel to zoom in and out.  

Left click and drag up and down to pan the y-axis. 

Use the y-axis context menu to change the y-axis scale mode.  The y-axis displays in linear coordinates 

by default, but also supports a logarithmic scale.  A logarithmic scale is very useful to display wide 

dynamic ranges for current and power. 

Use the y-axis context menu to hide the signal.  Click Settings at the top left to display the settings 

menu.  Select Add → [Signal Name] to display a signal not already shown. 
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Energy 
A Joulescope measures current and voltage two million times per second.  It then multiplies current by 

voltage to compute power.  Joulescope then integrates power over time to compute energy.  Joulescope 

displays energy in both the Multimeter view and Oscilloscope view.  This value starts accumulating when 

the software starts.  Use Tools → Clear Energy to reset it to zero at any time. 

The energy value provides a simple tool to observe changes, especially for software.  You can baseline 

the performance of an operation by recording the measured energy value.  You can then make changes, 

repeat the test, and observe the new energy value.  The oscilloscope view enables you to investigate in 

further detail. 

The Joulescope software is under active development, and new features are being added.  Future 

features will make analyzing and comparing energy consumption even easier. 

Open source 
The host software is open source and written in Python 3.6+.  The host software consists of two layers: 

Repo name Python package name Description 

pyjoulescope_ui joulescope_ui The Joulescope User Interface written in QT/PySide2 

pyjoulescope joulescope The Joulescope “driver” which enables scripting  

 

The joulescope package was designed so that you can script custom Joulescope actions and integrate 

Joulescope into your applications.  See the GitHub repositories for the latest details. 

https://github.com/jetperch/pyjoulescope_ui 

https://github.com/jetperch/pyjoulescope 

You can find examples for how to use Joulescope in your Python application at: 

https://github.com/jetperch/pyjoulescope_examples 

The Joulescope software depends upon other software and libraries.  See CREDITS.html for 

pyjoulescope_ui and pyjoulescope. 

https://github.com/jetperch/pyjoulescope_ui
https://github.com/jetperch/pyjoulescope
https://github.com/jetperch/pyjoulescope_examples
http://htmlpreview.github.io/?https://github.com/jetperch/pyjoulescope_ui/blob/master/CREDITS.html
http://htmlpreview.github.io/?https://github.com/jetperch/pyjoulescope/blob/master/CREDITS.html
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Theory of operation 
Joulescope simultaneously measures current and voltage, and then computes power and energy.  

Joulescope combines a voltmeter and a fast auto-range current shunt ammeter.   

 

Ammeter 
The ammeter consists of multiple shunt resistor values.  Joulescope actively adapts to keep the 

maximum voltage across the shunt resistor to 20 mV.  This low voltage drop minimizes the impact on 

the device under test.  Other equipment, including standard multimeters, have a much larger burden 

voltage that can cause the target device to behave unusually. 

As the current changes, the ammeter selects the optimal shunt resistor value.  Joulescope uses 

dedicated hardware to quickly select the appropriate shunt resistor to avoid impacting the device under 

test.  The shunt value selection uses the ADC output, dedicated over-range comparators, and a unique 

algorithm that runs in an FPGA.  The FPGA selects the active shunt resistors using MOSFETs, which were 

carefully qualified to meet Joulescope’s demanding performance characteristics. 

The shunt resistor selection does take some time.  How fast does the shunt resistor need to change to 

have minimal impact?  The linearized equation is: 

t = C * ΔV / ΔI   

Let’s take a typical example. The target device takes 3.3V and can tolerate a temporary 3% (0.03) 

voltage glitch on a 1 amp change.  If the target device has 10 μF of capacitance, the required shunt 

resistor switching time is approximately: 

10 μF * 3.3 V * 0.03 / 1 A = 1 μs   
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Joulescope was designed to achieve 1 µs switching speed to meet this demanding case.  Most target 

systems have larger capacitance and less dramatic step current changes.  In all cases, the shunt resistor 

selection is always make-before-break to ensure uninterrupted connectivity to the target device.   

Voltmeter 
Both the voltage and current are sampled 2 million times per second, and the sample data is sent to the 

computer.  Unlike traditional oscilloscopes, a Joulescope is always capturing data.  The terms “trigger” 

and “sample buffer” do not apply to the Joulescope device, and all sample data is sent to the host 

computer.  The Joulescope User Interface temporarily stores capture data in a circular buffer.  However, 

Joulescope can also record to a file, and the capture size is only limited by your computer’s available disk 

space. 

High impedance / low leakage 
Joulescope measures currents at nanoamp resolutions and accuracies.  Many contemporary devices 

have input impedances of 1 MΩ to 10 MΩ, which is not good enough.  At 3.3V, a 10 MΩ load draws: 

3.3V / 10 MΩ  = 330 nA 

Joulescope features a combined input impedance and leakage current of approximately 1 GΩ.  This high 

input impedance allows Joulescope to make accurate and precise low current measurements. 

Electrical isolation 
The sensor side of Joulescope is electrically isolated from the host computer.  This isolation allows you 

to insert Joulescope into your test system without worrying about ground issues including ground loops 

and ground noise.   
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How to swap the front panel 
Joulescope comes standard with a banana jack front panel.  However, Joulescope is designed to be 

flexible and can support other connector types. 

 

The front panel design is open source, and available on GitHub: 

https://github.com/jetperch/joulescope_front_panels 

To swap the front panel, you will need: 

• T15 Torx screwdriver 

• The new front panel 

Swapping the panel is easy, but you do need to take proper precautions to avoid damaging your 

Joulescope.  Joulescope can be damaged by static electricity that you don’t even notice.  When you 

expose the Joulescope main board, be sure only to handle it by the board edges.  Follow these steps 

carefully: 

• Completely disconnect the Joulescope, including IN, OUT and USB ports. 

• Use the Torx screwdriver to remove the four screws at the corners of the existing front panel. 

• Gently push the Joulescope’s USB connector into the Joulescope body.  This action will push the 

front panel out.  Expose about ½” or 1 cm.   

• Grab the sides of the main board in one hand, being careful not to touch any other part of the 

board.   

• Grab the existing front panel by the sides and carefully pull it directly out. 

• Grab the new front panel by the sides, align the pins, and carefully push it in. 

• Fully seat the front panel in the black plastic bezel.  You may need to gently guide the board to 

ensure that the USB connector fits in the back panel. 

• Use the Torx screwdriver to install the four screws at the corners of the existing front panel. 

 

https://github.com/jetperch/joulescope_front_panels
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GPI & GPO 
The Joulescope contains two (2) general purpose inputs (GPI) and two (2) general purpose outputs 

(GPO).  These signals enable time-synchronization with the device under test and other external 

equipment.  The user interface can display GPIs time-synchronized with current, voltage, and power in 

the oscilloscope view.   

One intended application for the GPIs is to allow the target microcontroller firmware to identify areas of 

interest.  The microcontroller can toggle bits so that you can easily see the energy consumption in the 

marked time windows.   

When the GPI feature is activated, the voltage and current samples will only be 13 bits (the GPI will be in 

the LSB), not the full 14-bits.  The GPI may also be configured to trigger a Joulescope capture.   

GPO1 emits a pulse on Joulescope capture start, which allows Joulescope to trigger other equipment.  

GPO2 is under software control. 

Both GPI and GPO are referenced to USB ground.  The GPI and GPO will support a 3.3V logic level at 

minimum, but programmable support for signal levels from 1.8V to 5.0V is planned. 

Many applications using Joulescope will want isolated GPI/GPO for improved performance.  We do plan 

to recommend and perhaps offer a separate isolation module that supports electrical isolation along 

with all the great features you would expect to make quality, low-power measurements including: 

• Electrical isolation 

• Self-powered target interface with very low power from target device – leakage currents only 

• Variable voltage technology levels with external reference voltage 

• ESD protection 

• Overvoltage protection (GPO) 

• Short circuit protection (GPO) 

• Very high (GΩ) input impedance (GPI) 

The GPI data collection is supported in the Joulescope production hardware and firmware.  The 

Joulescope User Interface 0.6.6+ supports GPI display.  To display either IN0 or IN1, select Settings → 

Add, then select either in0 or in1. 
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Electrical Isolation 
The Joulescope is electrically isolated between the USB interface and the IN/OUT sensor.  Joulescope is 

rated to ±48V between USB ground and any of IN+, IN-, OUT+, and OUT-.  The individual component 

ratings far exceed this specification.  The components are: 

Part # Mfgr Description Isolation 
working 

Isolation 
60s 

Isolation 
1 s 

760390014 Wurth Transformer 400 VRMS 2500 VAC 3125 VAC 

Si8661BB-B-IS1 Silicon Labs Digital isolator 445 VRMS  4500 VRMS 

TLP2361(TPL,E Toshiba Opto isolator 500 VRMS 3750 VRMS  

 

The printed circuit board (PCB) clearance between the isolated sensor side and the USB host side is 

1 mm.  The use of an aluminum enclosure effectively limits the isolation voltage and requires that USB 

chassis ground surrounds the sensor edges.  If you use Joulescope in a custom application without the 

standard enclosure, the four chassis ground rails (2 top & 2 bottom) can be cut around the isolation line 

to give a 4 mm PCB clearance between the USB host side and the sensor side. 
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Typical Behavior 
This section contains information regarding typical Joulescope behavior. 

Step Response 
Joulescope is a shunt ammeter with incredibly fast autoranging.  This section contains typical 

autoranging measurements. 

The test setup includes a Joulescope, a custom load board, a power supply, a computer and some 

cables.  A custom load board is the Joulescope target.  The load board was specifically designed for the 

sole purpose of creating very fast, repeatable edges.  It has a 1 MΩ resistor in parallel with a 1Ω resistor.  

The board contains a momentary pushbutton and debouncer which is the input to the MCP1416 

MOSFET driver.  The MCP1416 drives the FDMC7678 MOSFET which enables or disables the 1Ω resistor.  

The entire circuit is powered by a 9V battery and connected to the Joulescope OUT. 

The power supply is a Siglent SPD3303X-E bench supply configured for 1.00V and 2.9A.  The supply is 

connected to Joulescope IN.  Any bench supply with reasonable transient performance should do. 

 

Figure 1: The step response test setup 

The normal Joulescope user interface software captures data while pressing the target board’s switch to 

toggle the MOSFET & 1Ω resistor.  A custom Python script reads the data, processes the data, and 

creates plots.  The python script finds each edge and aligns them so that they can be plotted together.  

The plots show rising edges in the left column and falling edges in the right column.   

The first capture “step_2A.png” is the baseline with Joulescope autoranging disabled and set to a fixed 

2A range.  The rise time you see is due to the Joulescope bandwidth.  The actual edge is much, much 

faster.   
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Figure 2: Step response with fixed 2A range 

The second capture “step_autorange.png” is with autoranging.  The two samples after over-range tend 

to contain “garbage” data that messes up the y-axis range, so they are omitted.  These samples are 

captured at 2 MSPS (500 ns).  Joulescope’s stated bandwidth is 250 kHz (4 µs = 8 samples).   

 

Figure 3: Step response with autoranging 
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The Joulescope specification states that range switching occurs within 1.2 µs max.  This specification 

determines how much (or in the case of Joulescope, how little) voltage drop happens when the target 

changes current demands.  The Joulescope specification gives over-range settling time is 2 µs typical 

with 5 µs max.  This specification determines how well Joulescope can measure data through the 

transition.  Any autoranging ammeter needs to be VERY fast to limit voltage variations at the target 

device, and Joulescope was designed to meet these demanding requirements. 
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Compliance 
For additional compliance information, see 

https://www.joulescope.com/compliance/JS110 

 

United States 

FCC Notice 
This equipment has been tested and found to comply with the limits for a Class A digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial environment. This equipment 

generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 

with the instruction manual, may cause harmful interference to radio communications. Operation of this 

equipment in a residential area is likely to cause harmful interference in which case the user will be 

required to correct the interference at his own expense. 

Operation of this equipment in a residential area is likely to cause harmful interference in which case the 

user will be required to correct the interference at his own expense. 

Changes or modifications not expressly approved by the party responsible for compliance could void the 

user's’authority to operate the equipment. 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and (2) this device must accept any interference 

received, including interference that may cause undesired operation. 

Europe 
Warning – This is a Class A product. In a domestic environment this product may cause radio 

interference, in which case the user may be required to take adequate measures. 

 

In accordance with the European Waste Electrical and Electronic Equipment Directive 
(WEEE), this device needs to be recycled in accordance with local regulations.  

 

Safety 
Joulescope is an Extra-Low Voltage device as per IEC 60038.  Joulescope is intended for INDOOR USE 

only. 

RoHS Directive 2011/65/EU, 2015/863/EU 
This product is CE marked and complies with the European Union's’Directive 2011/65/EU OF THE 

EUROPEAN PARLIAMENT AND OF THE COUNCIL of 8 June 2011 on the restriction of the use of certain 

hazardous substances in electrical and electronic equipment. 

EU Directive 2015/863 of 31 March 2015 amends Annex II to Directive 2011/65/EU of the European 

Parliament and of the Council as regards the list of restricted substances. 

https://www.joulescope.com/compliance/JS110
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Country of origin 
United States of America 

Made in Maryland, USA. 
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Maintenance 
Joulescope is designed for minimal maintenance.  To clean your Joulescope, disconnect all wires from 

the unit.  You can gently wipe the unit with a damp cloth using water only.  Using rubbing alcohol or 

other cleaning agents may damage your Joulescope.  Do not submerge.   

Joulescope is factory calibrated and should continue to function within specifications over its operating 

life.  For critical or demanding applications, you may choose to follow industry-standard practices and 

have your Joulescope recalibrated annually.  Visit http://www.joulescope.com or contact 

support@jetperch.com for details.  Recalibrating Joulescope requires custom equipment and trained 

personnel.  Only Jetperch LLC is authorized to perform recalibration.   

http://www.joulescope.com/
mailto:support@jetperch.com
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Warranty 
The Joulescope JS110 is warranted to be free from defects in materials and workmanship for a period of 

one year from the date of purchase.  If your Joulescope becomes inoperative from such a defect within 

the warranty period, Jetperch will either repair or replace your unit, at Jetperch’s discretion. 

This warranty covers normal use.  The warranty does not cover damage which occurs during shipment.  

The warranty does not cover damage from improper use, misuse, abuse, tampering, alteration, accident, 

software hacking, or recalibration other than by an authorized recalibration provider. 

Jetperch LLC makes no other representations or warranties, express or implied, of any kind including, 

but not limited to, any implied warranty of merchantability or fitness for a particular purpose.  Jetperch 

shall not be liable for loss of use of Joulescope.  Jetperch will not be liable for any other incidental or 

consequential damages, expenses, or financial losses, nor will Jetperch be liable for claims of such 

damages.   

To submit a warranty claim, contact support@jetperch.com.  You will need to provide your name, 

address, phone number, and email.  You will also need to provide proof of purchase, such as a purchase 

receipt, that contains the original date of sale. 

mailto:support@jetperch.com
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Contact 
To purchase this product, visit: 

https://www.joulescope.com 

To submit a warranty claim, first review the warranty section above.  You can submit warranty claims to: 

support@jetperch.com 

If you have questions regarding operation of Joulescope, search the website at: 

https://www.joulescope.com/  

And visit the forum: 

https://forum.joulescope.com/ 

For compliance information, see 

https://www.joulescope.com/compliance/JS110 

If you wish to contact Jetperch regarding the operation of your Joulescope, contact us through email at: 

support@jetperch.com  

 

 

Location 

Jetperch LLC 

3470 Olney - Laytonsville Rd. 

Suite 104 

Olney, MD 20832-1734 

USA 

 

https://www.joulescope.com/
mailto:support@jetperch.com
https://www.joulescope.com/
https://forum.joulescope.com/
https://www.joulescope.com/compliance/JS110
mailto:support@jetperch.com
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Glossary 
 

Accuracy 

The average variation in the bias between measurements and truth.  Good measurements are both 

accurate and precise. 

Ammeter 

A device that measures electrical current. 

Burden Voltage 

The voltage drop that occurs through the test equipment device.  For shunt ammeters, the burden 

voltage includes the voltage across the shunt resistor, connectors, fuses, and any additional resistance in 

the device. 

Current 

The flow of electric charge per time from positive voltage to negative voltage, measured in amperes (A), 

often called amps.  One amp is one coloumb of charge flowing per second.  One coloumb is 

approximately 6.242 x 1018 electrons, but electric current is defined opposite to the electron flow. 

Energy 

The total power exerted over time, measured in joules (J).  Energy is the time integral of power. 

Insertion Loss 

The loss in signal power due to a device in the signal path, most commonly used in reference to radio 

frequency (RF) or telecommunications.  See Burden Voltage. 

Multimeter 

A multifunction device that usually incorporates a voltmeter and shunt ammeter, at a minimum.  A 

standard multimeter supports only one measurement quantity at a time. 

Ohm’s Law 

The equation that relates voltage, current and resistance: V = I * R 

Oscilloscope 

A device that graphically displays a one or more signals, usually voltages, varying over time as a two-

dimensional plot with time on the x-axis and the signal on the y-axis. 

Power 

The time-rate of doing work, measured in watts (W).  Power is voltage multiplied by current. 

Precision 

The amount of variation between measurements of the same value relative to each other.  Good 

measurements are both accurate and precise. 

Resistance 

The quantity of opposition to the flow of electric current. 

Shunt Ammeter 

An ammeter that measures the voltage across a resistor, and then uses Ohm’s Law to compute current. 
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Shunt Resistor 

The resistor used by “Shunt Ammeters” to detect current using Ohm’s Law:  I = V / R.  Given a known R 

and a measured V, the ammeter computes I. 

Universal Serial Bus (USB) 

The now ubiquitous standard for connecting computers and peripherals.  Joulescope connects to the 

host computer using USB 2.0. 

Voltage 

The electric potential difference, measured in volts (V). 

Voltmeter 

A device that measures electrical voltage. 
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User’s guide information 
This section contains information regarding this document.  See the other sections of this document for 

information regarding the Joulescope product. 

Copyright notice 
© 2019 Jetperch LLC 

All material in this User’s Guide, including the text, images, design, and logos, are owned by Jetperch 

LLC, either through copyright or trademark, unless otherwise indicated.  No part of this User’s Guide 

may be reproduced in any form or by any means without prior written consent from Jetperch LLC as 

governed by the United States and international copyright laws.   

Publisher 
Jetperch LLC 
3470 Olney – Laytonsville Rd 
Suite 104 
Olney, MD  20832-1734 
USA 

Warranty 
The Joulescope JS110 User’s Guide is provided AS-IS with no other representations or warranties, 

expressed or implied, of any kind including, but not limited to, any implied warranty of merchantability 

of fitness for a particular purpose.  Jetperch LLC does make reasonable effort to present accurate and 

reliable information in this Joulescope JS110 User’s Guide. 

The information in this User’s Guide is subject to change.  The most up-to-date version of this User’s 

Guide can be retrieved from http://www.joulescope.com/.   

Why is this document preliminary? 
The performance specifications in this document are derived from error analysis on the design.  The 

performance specifications were validated on 25 beta units, which have confirmed these specifications.  

Full performance qualification over the first production units is still pending.  The specifications herein 

are conservative, but final performance specifications may change.  

  

http://www.joulescope.com/
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Change log 
Revision Date Description 

0.6 2019 Oct 16 Added GPO current and power specifications. 
Added GPI information. 
Clarified annotations, markers and cursors. 
Increased over-range settling time from 3 µs to 5 µs. 
Updated directions for UI 0.6. 

0.5 2019 Jun 20 Added table of contents to table of contents. 
Updated GPI/O section for production rev H.  Added statement about 
software support. 
Fixed typos and grammar. 
Updated compliance information. 
Updated for 0.4.x software. 
Updated “Why is the document preliminary”. 

0.4 2019 Mar 11 Updated electrical isolation section for rev E 

0.3 2019 Mar 1 Added electrical isolation section 
Added GPI/GPO 
Added Typical Behavior section with step response 
Fixed SI unit capitalization: See the definitive SI Brochure 

0.2 2019 Feb 12 First public release 

0.1 2018 Dec 17 Initial draft 

 

https://www.bipm.org/en/publications/si-brochure/section5-2.html

